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Objectives 
 
For 5-Axis-Lesson-2 you will generate the toolpaths to machine the part on a CNC vertical 
milling machine with multi-axis capability.  The part will be held in a machine vise and a 
Trunnion table as shown below will be utilised to machine the angled face, end radii and drill all 
the holes 
This Lesson covers the following topics: 
 
Open an existing file containing: 
The solid geometry for the machine vise 
Solid geometry for the part 
 
Establish Stock Setup settings: 
Stock size 
Material for the part 
Feed calculation 
 
Generate toolpaths consisting of: 
Flow 5 Axis toolpath 
Drill 5 Axis toolpath 
 
Inspect the toolpath using Mastercam’s Verify and Backplot by: 
Launching the Verify function to machine the part on the screen 
Generating the NC- code 
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5-AXIS LESSON-2 DRAWING 
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TOOL LIST 
Two cutters will be used to create this part.   
1.000” diameter flat end mill to machine the 30 Degree angle and the end radii 
0.250” diameter flat center cutting end mill to drill the holes 
 

  

5-AXIS-LESSON-2 - THE PROCESS 

 

Toolpath Creation 
 
TASK 1:  Setting the environment 
TASK 2:  Introduction - Watch the video 
TASK 3:  Open an Existing file from the Multimedia CD 
TASK 4:  Identify the entities on each Level 
TASK 5:  Use Flow 5 Axis toolpath to machine the 30 Degree angle and 

the end radii 
TASK 6:  Drill the holes using the Drill 5 Axis toolpath 
TASK 7:  Backplot the toolpath 
TASK 8:  Verify toolpaths 
TASK 9:  Post and create the CNC code file 
 

Sam
ple 

not fo
r 

Dist
rib

utio
n



Five-Axis-Lesson-2 
 

Five-Axis-Lesson-2-4 

THE HAAS VF-5/50TR (TOP) & 

 VR-8 5-AXIS MACHINING CENTERS    
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Toolpath Creation 
TASK 1:  
SETTING THE ENVIRONMENT 
Before starting the geometry creation you should set up the grid, toolbars and machine type as 
outlined in the Setting the environment section at the beginning of this text: 
1. Set up the Grid.  This will help identify the location of the origin. 
2. Customize the toolbars to machine a 4-5 Axis part. 
 

TASK 2: INTRODUCTION – WATCH THE VIDEO 
1. Before you start to work on this Lesson review the Introduction video on the multimedia CD 

that came with this text.  You will find the video in the “Lesson-2” section, it is entitled 
Introduction - 10 Minutes.   

 The video will review the techniques that will be used to generate the toolpaths using Flow 5 
Axis and Drill 5 Axis toolpaths utilizing the Trunnion table. 

     

 
TASK 3: 
OPEN EXISTING FILE FROM THE MULTIMEDIA CD 
 
 On the multimedia CD that came with this text is a folder called Mastercam-Files. The file 

will contain the wireframe geometry of the part and the vise constructed as a solid.   The 
part is already setup for a: GENERIC HAAS VF-TR_SERIES 5X MILL. 

 
1. Select File>Open> 5-Axis-Lesson-2.   
2. Activate a shaded view by selecting the icon at the top of the screen. The file should appear 

as below.  The vise is made up of solid features, the part includes a mixture of wireframe, 
solid and surface geometry.   
The Stock setup has already been setup.  

 
 
3. Display the Operations Manager.  

Selecting Alt-O will Show/hide the 
Operations Manager pane. 
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TASK 4: 
IDENTIFY THE ENTITIES ON EACH LEVEL 
 
Before you start to work on the two toolpaths lets first identify the entities on each Level. 
During this lesson you will turn the visibility of Levels off and on. 
 

 Levels are a primary organizational tool in Mastercam. A Mastercam file can contain 
separate levels for wireframe, surfaces, drafting entities, and toolpaths.  

 By organizing your files into levels, you can more easily control which areas of the drawing 
are visible at any time and which parts are selectable so that you do not inadvertently make 
changes to areas of the drawing you do not want to change. 

 
1. From the Status bar at the bottom of the screen select Level. 

  
 
2. The Level Manager dialog window will now appear. Zoom and pan the display so you can 

see both the part and vise on the right hand side of the screen, with the Level Manager 
dialog window on the left of the screen. 

  
 
3. As you can see in the picture above there are five levels in this part named: 1, 2, 3,100 and 

101.  Only Level 1 and Level 100 are visible as noted below by the X in the Visible column. 
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4. At the bottom of the Level Manager dialog box remove the check mark from Make main 
level always visible.  Then click on the two X’s in the Visible column to turn off the display 
of Level 1 and 100.  All the entities have now been removed from the screen and only the 
outline of the stock is shown. 

  
 
5. Now we will take a look at what is on each level.  Click in the Visible column for Level 2 to 

make it visible as shown below, an X will now appear in the Visible column.  This Level 
contains a surface that represents the angled face, the radii and the end faces of the part.  
You will use this surface for the 5 Axis Flow toolpath. 

 

 
        
6. Now click in the Visible column for Level 3.  This Level contains a series of points at the 

centres of the holes you will be drilling. 
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7. Now click in the Visible column for Level 100 and 101.  These two Levels contain the 
geometry for the vice. 

 

 
 
8. Now display only Level 1. Click in the Visible column for Level 1 to activate the X and 

click in the remaining Visible columns to remove the X as shown below.  Level1 contains 
the solid geometry for this part. 

 

 
 
9. Now display only Level 2 the Drafted Surface. 

 

 
 

10. Select the OK button  to exit the Level Manager dialog box. 
 
 Your part should look similar to the screen shot above right. 
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TASK 5: 
USE FLOW 5 AXIS TOOLPATH TO MACHINE THE 30 DEGREE ANGLE 
AND THE END RADII 
In this task you will use a 1.0 diameter flat end mill to machine the angled face and the radii 
only.  
All other faces have been previously machined. 
 
1. Set the graphics view to the Isometric View by using the toolbar icon at the top of the 

screen.  

2. Select the Screen Fit icon found at the top of the screen to fit the part to the screen . 
3. From the menu bar select Toolpaths>Multiaxis 

 
 
4. If prompted to Enter new NC name ensure 5-Axis-Lesson-2 is displayed and then select 

the OK button . If not prompted then continue to the next step. Sam
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5. On the screen you will now see the Multiaxis Toolpath dialog box set to the Toolpath Type 
page. Select the Flow icon as shown below: 

 
 

 Use this page to establish the type of multiaxis toolpath to create.  Toolpath type controls 
the options available as you proceed down the tree structure. The options are based on the 
toolpath family selected using the Calculation based on buttons, as well as by selecting the 
picture of the toolpath you wish to create. 

 Calculation based on: 
 Click a button to select a multiaxis toolpath family. This initial selection determines the 

toolpaths available to you in the window below. Each toolpath family offers a handful of 
toolpaths, although you have over two dozen multiaxis toolpaths available in total. 

 

 Flow allows either precise control of the scallops left on the part or constant distance 
stepovers, creating an exact, smooth finish.  

 Flow produces tool motion based on your selected surfaces and tool axis options. The tool 
is generally compensated to the selected pattern surfaces, although it is possible to set 
separate compensation surfaces.  

 In general, Flow works best on a single surface, or row of surfaces whose UV lines are 
oriented in the same manner and direction.  

 Flow is an expansion of the MSurf toolpath type that places more of the control in your 
hands. 
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6. On the left of the dialog box select Tool.  Click on the Select library tool button, de-activate 
the Filter Active button and choose a 1.0” Flat Endmill.  Make changes to this page as 
shown below: 

 
 
7. On the left of the dialog box select Cut Pattern.  Now click on the Select surfaces button to 

return to the graphics window for surface selection. 

 

 Surfaces  
 Multiple surfaces may be selected provided 

the surfaces form a contiguous row, or where 
the surface directions are not in conflict with 
one another.  

 
 The number of surfaces selected is displayed 

to the right of the select button. 

 
 
8. When prompted to Select Tool Pattern Surface(s) select the three surfaces shown below. 

Surface 1 is the radius, Surface 2 is the angled face and Surface 3 is the radius. 
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9. Click on the End Selection icon. .  

 

Flip 
Offset 
Toggles the tool compensation offset direction between the 
surface normal and opposite the surface normal.  
 
Cut direction 
Toggles the toolpath between the cut directions:  Across is 
parallel to the shared edge of the toolpath. Along is 
perpendicular to the shared edge of the toolpath.  
 
Step direction 
Toggles the direction of the tool step over. 
 
Start 
Selects the start point of the toolpath. 
 
Edge tolerance 
Determines which edges are considered “shared” and which 
are “free” when creating flowlines along the row or grid of drive 
geometry. 
 
Plot edges 
Use this option to identify the shared and free surface 
edges.  Shared edges are the edges between adjacent 
surfaces. Free edges are any edges that aren't shared.  
 

 

10. Select the OK button  to exit the Flowline data dialog box. 
11. Back at the Cut pattern page set the values as shown below: 
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12. On the left of the dialog box select Tool Axis Control and set the values as shown below: 

 

 Lead/lag angle 
Lead:  Tilts the tool 
forward in the 
direction of the 
toolpath. 
Lag: Tilts the tool 
backward from the 
direction of the 
toolpath. 
This is important 
when using a ball 
nose cutter.  It 
allows you to cut 
with the side of the 
ball nose rather tan 
the tip. 

 

 

 Tool Axis Control: Pattern surface 
 Keeps the tool axis vector normal to a selected surface. For Multisurface 5-axis toolpaths, 

keeps the tool axis vectors normal to the surfaces selected for the cut pattern. (The cut 
pattern is a set of surfaces that best defines the general machining area for the operation 
and defines the general flow of tool motion.)  

 Output Format: 5 axis 
 Provides tool axis rotation in two planes. Use 5-axis output when the machine tool supports 

two rotary axes. 

 
13. On the left of the dialog box select Linking and set the values as shown below: 
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14. On the left of the dialog box select Roughing.  Check mark Depth cuts and make changes 
as shown below: 

 
 

15. Select the OK button  to exit Multiaxis Toolpath - Flow. 
16. Select the Verify selected operations button and verify this toolpath.  Oops - As you can see 

the cutter ploughs through the part.  In the next steps you will correct this collision. 

 
 
17. Click on the Parameters folder for the Flow 5 Axis toolpath. 
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18. Click on the plus sign to the left of Linking to expand the list. Select the Home/Ref. Points 
page and activate Reference points and set the values as shown below. 

 

 Reference points 
 A reference point is a location 

that the tool moves to between 
the home position and the start 
or end of the toolpath.  

 You can create separate 
reference points for both 
approach and retract moves.  

 Use this dialog box to set 
reference points for the current 
operation, or to set default 
reference points for an axis 
combination within a machine 
definition. 

 
19. Now select the Roughing parameters page and remove the check mark from Keep tool 

down as shown below: 

 

 Keep tool down 
When selected, does not retract the tool between 
passes. 

 

 

20. Select the OK button  to exit Multiaxis Toolpath - Flow. 

21. Select the Regenerate all dirty operations button  to remove the red X from the 
operation you have just edited.  You need to update the toolpath with the new parameters 
you have just input. 

22. Select the Verify selected operations button and verify this toolpath.   

 

 The collision is now eliminated with a 
combination of Ref Points and the removal 
of the Keep tool down option in Multiaxis 
Depth cuts. 
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TASK 6: 
DRILL THE HOLES USING THE DRILL 5 AXIS TOOLPATH 
 
In this task you will use a 0.250 diameter flat center cutting end mill to drill all the holes 
The holes will be drilled to a depth of 0.250. 
 

1. Set the graphics view to Isometric View.  

2. Select the Screen Fit icon found at the top of the screen to fit the part to the screen  
 
3. Turn off the display of toolpaths by selecting Alt-T on your keyboard. 
 
4. From the Status bar at the bottom of the screen select Level. 

  
 
5. Now click in the Visible column for Level 3.  Level 2 contains a surface and Level 3 

contains a series of points at the centres of the holes you will be drilling.  Ensure that you 
turn off the visibility for all levels except Level 2 and 3. 

 
 

6. Select the OK button  to exit the Level Manager dialog box. 
7. From the menu bar select Toolpaths>Multiaxis 
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8. On the screen you will now see the Multiaxis Toolpath dialog box set to the Toolpath Type 
page. Click on the Drill/Circle Mill button and then select the Drill icon as shown below: 

 
 
9. On the left of the dialog box select Tool.  Click on the Select library tool button, de-activate 

the Filter Active button and choose a 0.25” Flat Endmill.  Make changes to this page as 
shown below: 

 
 
10. On the left of the dialog box select Cut Pattern. Open the Cycle drop down menu and 

change to Drill/Counterbore.  Now click on the Select Points button  to return to the 
graphics window for Point selection. 
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11. From the Drill Point Selection dialog box select Window Points. 
12. On the graphics screen you will be prompted to Pick window corners. Draw a window 

around the part to capture the points as shown below.   

  
 

13. Select the OK button  to exit the Drill Point Selection dialog box. 
14. Ensure the changes to the Cut Pattern page are as shown below: 

 
 

 Entity type: Points 
 Drills selected points. Choose the Points button to return to the graphics window and select 

points for the toolpath. 
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15. On the left of the dialog box select Tool Axis Control. Open the Tool axis control drop 
down menu and change to Surface.  

16.  Open the Output format drop down menu and change to 5 axis.  

 
 

17. Click on the Select Surfaces button  for the Tool Axis Control section. 
18. On the graphics screen you will be prompted to Select Tool Axis Surfaces(s)  select the 

four surfaces shown below. Surface 1 is the radius, Surface 2 is the angled face, Surface 3 
is the radius and Surface 4 is the back face. 

. 

19. Click on the End Selection icon. . 
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20. Before moving on check the Tool axis control settings are as shown below: 

 
 

 Tool axis control: Surface 
Keeps the tool axis vector normal to a selected surface. For Multisurface 5-axis toolpaths, keeps 
the tool axis vectors normal to the surfaces selected for the cut pattern. (The cut pattern is a set 
of surfaces that best defines the general machining area for the operation and defines the 
general flow of tool motion.) Choose the Surface button to return to the graphics window and 
select a surface.  
Surface is the only tool axis control option available for 3-axis output.  For 3-axis output, 
Mastercam projects the curves onto the tool axis surfaces. The projected curves become the 
tool contact positions. 
 Output Format: 5 axis 
Provides tool axis rotation in two planes. Use 5-axis output when the machine tool supports two 
rotary axes. 
 Backplot rotary 5 axis: 5 axis 
Select the X, Y, or Z-axis to be used in backplot to represent the rotary axis. Match this setting 
to the rotary axis capabilities of your machine for 4-axis output. 

 
21. On the left of the dialog box select Collision Control.  Make changes to this page as shown 

below: 

 
 

 Tip Control: Original point: Select to start the tool tip on the selected point. The toolpath 
values are calculated from the original point's position. 
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22. Select the Linking parameters page and make the changes as shown below: 

 
 

23. Select the OK button  to exit the Multiaxis Toolpath - Drill. 
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TASK 7: 
BACKPLOT THE TOOLPATH 
 In this task you will use Mastercam’s Backplot function to view the path the tools take to cut 

this part.  
 Backplot will enable you to review the cutting motions and identify any problem areas when 

cutting the part.  
 
1. Now you will make the Level visible that contains the geometry for the vise and the level 

that contains the solid geometry for the part.  From the Status bar at the bottom of the 
screen select Level. 

 
 
2. The Level Manager dialog window will now appear.  In the Visible column click on the 

visible column for Level 1 and level 100 so the X appears to make these levels visible.  
Now turn off the visibility of Level 2 and 3,  

 
 

3. Click on the OK button when done . 

4. Select the Screen Fit icon found at the top of the screen to fit the part to the screen  
5. Select Alt-T on your keyboard to display toolpaths.   
6. If required activate a shaded view by selecting the icon at the top of the screen. 

 
 
Your part should look similar to the screen shot below.   
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7. To pick all the operations to backplot pick the Select All icon  circled below: 
8. The next step is to select the Backplot selected operations icon shown below: 

 
 
9. Maximize the Backplot/Verify window if required.   
10. Select the Home Tab if required. 
11. Activate the options shown below in the Visibility section of the Home tab. 

 
 
12. Click on the Backplot tab at the top left of the screen. 

 
13. Activate the Both option in the Toolpath section of the Backplot tab. 

 
 
14. In the lower right corner of the screen now set the run Speed to slow by moving the slider 

bar pointer over to the left as shown below. 

 
 
15. Now select the Play Simulation button to review the toolpaths. 

 
 

16. After reviewing the Backplot of the toolpaths use the Close button  to exit Backplot. 
Your part should look similar to the screen shot below.   
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TASK 8:  
VERIFY THE TOOLPATHS 

1. In the Toolpath Manager pick all the operations to verify by picking the Select All icon . 
2. Select the Verify selected operations button shown below: 

 
 
3. Maximize the Backplot/Verify window if required. 
 
4. Activate the options shown below in the Visibility section of the Home tab. Initial Stock and 

Toolpath not activated. 

 
 
5. Activate the Color Loop to change the color of the tools for the verified part. 
6. In the lower right corner of the screen now set the run Speed to slow by moving the slider 

bar pointer over to the left as shown below. 

 
 
7. Now select the Play Simulation button to review the toolpaths. 

 
 
 Your part should look similar to the screen shot below.   

 
 

8. Select the Close button    in the top right hand corner to exit Verify. 
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TASK 9:  
POST AND CREATE THE CNC CODE FILE 

1. Ensure all the operations are selected by picking the Select All icon  from the Toolpath 
manager. 

 
 
2. Select the Post selected operations button from the Toolpath manager. 
3. Please Note: If you cannot see G1 click on the right pane of the Toolpath manger window 

and expand the window to the right. 

 
 
4. In the Post processing window, make the necessary changes as shown below: 

 
 

5. Select the OK button  to continue. Sam
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6. Enter the same name as your Mastercam part file name in the NC File name field 5-AXIS-
LESSON-2 and select the Save button 

 
7. If you encounter the dialog window below enter 90 for the primary axis angle. 

 

8. Select the Save button and review the CNC code. 

 
 

9. Select the  in the top right corner to exit the CNC editor. 
10. This completes 5-Axis-Lesson-2. 
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5-AXIS-LESSON-2 EXERCISE #1 
5-AXIS-LESSON-2-EX-1.MCX-6 

 
 
 

Sam
ple 

not fo
r 

Dist
rib

utio
n



Five-Axis-Lesson-2 
 

Five-Axis-Lesson-2-28 

5-AXIS-LESSON-2 EXERCISE #1 
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 5-AXIS-LESSON-2 EXERCISE #2 
5-AXIS-LESSON-2-EX-2.MCX-6
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5-AXIS-LESSON-2 EXERCISE #2 
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